
HMI series
HMI TOUCH SCREEN

410-710-810-820-830

Quick start guide - Guida breve all’installazione

12”

10”

7”

4,3”





Table of contents
1	 Safety guidelines........................................................................................................................................................... 5

1.1	 Policies and procedures............................................................................................................................... 5
1.2	 Installation guidelines.................................................................................................................................. 5
1.3	 Viruses and dangerous programs............................................................................................................. 5
1.4	 Organization of safety notices................................................................................................................... 6

2	 Spacing for air circulation and ventilation............................................................................................................. 6
3	 Device installation........................................................................................................................................................ 6
4	 Power supply and grounding.................................................................................................................................... 7
5	 Wiring connections...................................................................................................................................................... 8
6	 Technical data............................................................................................................................................................... 8

6.1	 Main features................................................................................................................................................. 8
6.2	 Hardware features........................................................................................................................................ 8
6.3	 Touch LCD: 4 wires resistive......................................................................................................................... 8

7	 Communication interfaces......................................................................................................................................... 8
7.1	 CANopen......................................................................................................................................................... 9

7.1.a	 Using CAN / EXP1 on terminal M1 (Not available for -EL versions)........................................ 9
7.2	 RS232................................................................................................................................................................ 9

7.2.a	 Using RS232 / COM1 on DB9 (Not available for TD410 and -EL versions)............................. 9
7.3	 RS485................................................................................................................................................................ 9

7.3.a	 Using RS485 / COM2 on terminal M1............................................................................................ 9
7.3.b	 Using RS485 / COM2* MASTER on DB9 (Not available for TD410 and -EL versions)........ 10
7.3.c	 Using RS485 / COM2 SLAVE on DB9 (Not available for TD410 and -EL versions).............. 10

7.4	 USB interfaces............................................................................................................................................... 10
8	 Ethernet interface....................................................................................................................................................... 11

8.1	 Technical data.............................................................................................................................................. 11
9	 Internal ethernet Switch (only TD810-TD820-TD830)........................................................................................ 11
10	 Battery........................................................................................................................................................................... 11

10.1	 Internal battery replacement................................................................................................................... 11
10.2	 Battery detail................................................................................................................................................ 12

11	 TdControlPanel............................................................................................................................................................ 12
11.a	 WIN EXPLORER....................................................................................................................................................... 13
11.b	 HMI_MOVICON..................................................................................................................................................... 13
11.c	 PLC LOGICLAB........................................................................................................................................................ 13
11.d	 LAN ETH1................................................................................................................................................................. 13
11.e	 BACKLIGHT - BUZZER........................................................................................................................................... 14
11.f	 WINVNC................................................................................................................................................................... 14
11.g	 BACKUP-RESTORE................................................................................................................................................. 14

12	 LogicLab Suite.............................................................................................................................................................. 16
12.a	 Language modification....................................................................................................................................... 16
12.b	 Create - load a project......................................................................................................................................... 17
12.c	 Connection to target............................................................................................................................................ 17
12.d	 Compiling and downloading the code............................................................................................................ 18
12.e	 Watch window....................................................................................................................................................... 18

13	 Interfacing Movicon 11 with LogicLab................................................................................................................... 19
13.a	 Creating a new Movicon project....................................................................................................................... 19
13.b	 Driver configuration.............................................................................................................................................20
13.c	 Downloading the Movicon code to the target.............................................................................................. 21

14	 Simulation of the whole project SoftPLC + SCADA............................................................................................. 21

Indice degli argomenti
1	 Norme di sicurezza..................................................................................................................................................... 24

1.1	 Regolamenti e procedure.......................................................................................................................... 24
1.2	 Linee guida per l’installazione................................................................................................................. 24
1.3	 Virus e programmi pericolosi................................................................................................................... 24



1.4	 Organizzazione delle note di sicurezza................................................................................................. 25
2	 Spazi per la circolazione dell’aria e la ventilazione............................................................................................ 25
3	 Installazione del dispositivo..................................................................................................................................... 25
4	 Alimentazione e messa a terra dello strumento.................................................................................................. 26
5	 Collegamenti elettrici................................................................................................................................................. 27
6	 Dati tecnici.................................................................................................................................................................... 27

6.1	 Caratteristiche generali............................................................................................................................. 27
6.2	 Caratteristiche hardware.......................................................................................................................... 27
6.3	 LCD touch: 4 fili resistivo............................................................................................................................ 27

7	 Interfacce di comunicazione.................................................................................................................................... 28
7.1	 CANopen....................................................................................................................................................... 28

7.1.a	 Utilizzo CAN / EXP1 su morsetto M1 (Non disponibile su versioni -EL)................................28
7.2	 RS232.............................................................................................................................................................. 28

7.2.a	 Utilizzo RS232 / COM1 su DB9 (Non disponibile per TD410 e versioni -EL)......................... 28
7.3	 RS485.............................................................................................................................................................. 29

7.3.a	 Utilizzo RS485 / COM2 su morsetto M1.......................................................................................29
7.3.b	 Utilizzo RS485 / COM2* MASTER su DB9 (Non disponibile per TD410 e versioni -EL)...... 29
7.3.c	 Utilizzo RS485 / COM2 SLAVE su DB9 (Non disponibile per TD410 e versioni -EL)............29

7.4	 Interfaccia USB.............................................................................................................................................30
8	 Interfaccia Ethernet....................................................................................................................................................30

8.1	 Dati tecnici....................................................................................................................................................30
9	 Switch ethernet interno (solo TD810-TD820-TD830)..........................................................................................30
10	 Batteria.......................................................................................................................................................................... 31

10.1	 Sostituzione batteria tampone interna................................................................................................. 31
10.2	 Dettagli della batteria................................................................................................................................ 31

11	 TdControlPanel............................................................................................................................................................ 31
11.a	 WIN EXPLORER....................................................................................................................................................... 32
11.b	 HMI_MOVICON..................................................................................................................................................... 32
11.c	 PLC LOGICLAB........................................................................................................................................................ 32
11.d	 LAN ETH1................................................................................................................................................................. 33
11.e	 BACKLIGHT - BUZZER........................................................................................................................................... 33
11.f	 WINVNC................................................................................................................................................................... 33
11.g	 BACKUP-RESTORE................................................................................................................................................. 33

12	 Suite LogicLab..............................................................................................................................................................36
12.a	 Cambio lingua.......................................................................................................................................................36
12.b	 Creazione - caricamento di un progetto.........................................................................................................36
12.c	 Collegamento al target....................................................................................................................................... 37
12.d	 Compilazione e scaricamento del codice........................................................................................................ 37
12.e	 La watch window..................................................................................................................................................38

13	 Interfacciare Movicon 11 con LogicLab.................................................................................................................38
13.a	 Creazione di un nuovo progetto Movicon......................................................................................................38
13.b	 Configurazione del Driver................................................................................................................................... 39
13.c	 Trasferimento del codice Movicon nel target.................................................................................................40

14	 Simulazione dell’intero progetto SoftPLC + SCADA........................................................................................... 41



User manual - HMI Series - 5

1	 Safety guidelines
Programmable logic controllers (PLCs), operating/monitoring devices (industrial PCs, HMI) have 
been designed, developed and manufactured for conventional use in industrial environments. They 
were not designed, developed and manufactured for any use involving serious risks or hazards that 
could lead to death, injury, serious physical damage or loss of any kind without the implementation 
of exceptionally stringent safety precautions. In particular, such risks and hazards include the use of 
these devices to monitor nuclear reactions in nuclear power plants, their use in flight control or flight 
safety systems as well as in the control of mass transportation systems, medical life support systems 
or weapons systems.

1.1	 Policies and procedures
Electronic devices are never completely failsafe. If the programmable control system, operating/
monitoring device or power supply fails, the user is responsible for ensuring that other connected 
devices, e.g. motors, are brought to a secure state.
When using programmable logic controllers or operating/monitoring devices as control systems 
together with a soft PLC, safety precautions relevant to industrial control systems must be observed 
in accordance with applicable national and international regulations. The same applies for all other 
devices connected to the system, such as drives.
All tasks such as the installation, commissioning and servicing of devices are only permitted to be 
carried out by qualified personnel. Qualified personnel are those familiar with the transport, mounting, 
installation, commissioning and operation of devices who also have the appropriate qualifications 
(e.g. IEC 60364). National accident prevention regulations must be observed.
The safety notices, information on connection conditions (type plate and documentation) and limit 
values specified in the technical data are to be read carefully before installation and commissioning 
and must always be observed.

1.2	 Installation guidelines
•	 These devices are not ready for use upon delivery and must be installed and wired according to the 

specifications in this documentation in order for the EMC limit values to apply.
•	 Installation must be performed according to this documentation using suitable equipment and tools.
•	 Devices are only permitted to be installed by qualified personnel without voltage applied. Before 

installation, voltage to the control cabinet must be switched off and prevented from being switched 
on again.

•	 General safety guidelines and national accident prevention regulations must be observed.
•	 Electrical installation must be carried out in accordance with applicable guidelines (e.g. line cross 

sections, fuses, protective ground connections).

1.3	 Viruses and dangerous programs
This system is subject to potential risk each time data is exchanged or software is installed from a data 
medium (e.g. diskette, CD-ROM, USB flash drive, etc.), a network connection or the Internet. The user is 
responsible for assessing these dangers, implementing preventive measures such as virus protection 
programs, firewalls, etc. and making sure that software is only obtained from trusted sources.

Table of contents
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1.4	 Organization of safety notices
Safety notices in this manual are organized as follows:
Safety notice Description
Danger! Disregarding these safety guidelines and notices can be life-threatening.

Warning! Disregarding these safety guidelines and notices can result in severe injury or 
substantial damage to property.

Caution! Disregarding these safety guidelines and notices can result in injury or damage to 
property.

Information! This information is important for preventing errors.

2	 Spacing for air circulation and ventilation
In order to guarantee sufficient air circulation, allow 5cm of empty space above, below, to the side 
and behind the device. No other ventilation system is required. The HMI device is self-ventilated and 
approved for inclined mounting at angles up to ±35°in stationary cabinets.

Information! If additional space is needed to operate or maintain the device, this must be taken into 
consideration during installation.

Caution! The spacing specifications for air circulation are based on the worst-case scenario for 
operation at the maximum specified ambient temperature. The maximum specified ambient 
temperature must not be exceeded!

Caution! An inclined installation reduces the convection by the HMI device and therefore the 
maximum permissible ambient temperature for operation.

3	 Device installation
The device panel is installed in the cutout using provided plastic hooks. The number of provided 
plastic hooks depends on the panel. The thickness of the wall or cabinet plate must be between 1 mm 
and 5 mm. An ISO 7045 (ex UNI 7687 DIN 7985A) Phillips screwdriver is needed to tighten and loosen 
the screws on the retaining clips. The maximum tightening torque for the retaining clips is 0,5 Nm.
Devices must be installed on a flat, clean and burr-free surface; uneven areas can cause damage to 
the display when the screws are tightened or the intrusion of dust and water. (as per figures 1 and 2)

Cut-out Fig. 1 Fig. 2

Lc (± 0,5 mm)

Hc (± 0,5 mm)
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Dimensions

Suggested thickness
Spessore suggerito
2 ÷ 8 mm

Suggested thickness
Spessore suggerito
2 ÷ 8 mm

TDXXX

LW

Wc

Hc

H

Lc
Suggested thickness

Spessore suggerito
2÷8 mm

Models L H W * Wc * Lc Hc
TD410-AD 140 100 36 30 130 89
TD710-AD 204 160 41 35 181 144
TD810-AD 274 216 40 31 260 200
TD820-AD 317 256 42 33 302 242
TD830-AD 406 270 50 41 391 255

*	 Dimensions refer only to the product without the size of terminals and cables.

4	 Power supply and grounding
Danger! This device is only permitted to by supplied by a SELV / 
PELV (class 2) power supply or with safety extra-low voltage (SELV) 
in accordance with EN 60950.

Connect a 24VDC 1,0A (min.) power supply, as showed into the 
figure. Connect the device grounding with a conductor of 18AWG 
(2,5mmq) minimum section. For the whole series it is suggested to 
use a 24 VDC 1,0A 24VA power supply (Pixsys code 2700.10.008).
Use Copper, Copper-Clad Aluminium or Aluminium conductors wire 
for all electric connection.

Caution! 24VDC power supply line must be protected by a 1,0A fuse.
Caution! Functional ground must be kept as short as possible and 
connected to the largest possible wire cross section at the central 
grounding point (e.g. the control cabinet or system).
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5	 Wiring connections
This device has been designed and manufactured in conformity to Low Voltage Directive 2006/95/EC, 
2014/35/EU (LVD) and EMC Directive 2004/108/EC, 2014/30/EU (EMC). For installation into industrial 
environments please observe following safety guidelines:
•	 Separate control lines form power wires;
•	 Avoid proximity of remote control switches, electromagnetic contactors, powerful engines and use 

specific filters;
•	 Avoid proximity of power groups, especially those with phase control;
•	 It is strongly recommended to install adequate mains filter on power supply of the machine where 

the controller is installed, particularly if supplied 230 VAC. The controller is designed and conceived 
to be incorporated into other machines, therefore CE marking on the controller does not exempt the 
manufacturer of machines from safety and conformity requirements applying to the machine itself.

6	 Technical data
6.1	 Main features

TD410 * TD710 ** TD810 TD820 TD830-AD
Power supply voltage 12 ÷ 24 VDC ± 10%
Consumption (typical 
use with 2 USB devices) 7.5VA 13VA 16VA 15VA 20VA

Temperature range 0...50°C
Humidity range 10...90% (without condensation)

*	 entry level (-EL) model available without USB, DB9 connectors (RS232 / RS485), CAN and Ethernet ports.

**	 entry level (-EL) model available without USB, DB9 connectors (RS232 / RS485) and CAN port.

6.2	 Hardware features
CPU ARM® CORTEX™ - A8 @1.0GHz
RAM 512 MB DDR3
eMMC 4GB

6.3	 Touch LCD: 4 wires resistive
TD410-AD TD710-AD TD810-AD TD820-AD TD830-AD

Resolution 4.3” TFT
480 x 272

7” TFT 
800 x 480

10” TFT 
800 x 600

12” TFT 
1280 x 800 

15,6” TFT 
1366 x 768 

Colors 65K (16 bit) 65K (16 bit) 65K (16 bit) 65K (16 bit) 65K (16 bit) 
Back-lighting LED 400 cd/m2 LED 280 cd/m2 LED 320 cd/m2 LED 220 cd/m2 LED 300 cd/m2
Back-lighting 
duration* 50000 h Typ @ 25°C** 30000 h Typ @ 25°C** 50000 h Typ @ 

25°C**
Lifetime** 17 10 17

*	 Brightness reduction to 80% of default setting  /  **	 Functioning years per 8 hours / day

7	 Communication interfaces
TD410-AD TD710-AD*** - TD810-AD*** - TD820-AD - TD830-AD

***	ETH2 not available on this model.
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7.1	 CANopen
7.1.a	 Using CAN / EXP1 on terminal M1 (Not available for -EL versions)

456 3 2 1

O
N

O
FF

DIP2 (DIP1 for TD410 with switch 
5/6 ONLY for internal use)
EXP1/CAN with termination 
resistor 120Ω

PIN5: GND (brown)
PIN6: CANH (blue)
PIN7: CANL (white)

7.2	 RS232
7.2.a	 Using RS232 / COM1 on DB9 (Not available for TD410 and -EL versions)

Standard RS232 connection:
PIN2: RX (green)
PIN3: TX (blue)
PIN5: GND (brown)

RS232 connection with RTS / CTS:
PIN2: RX (green)
PIN3: TX (blue)
PIN5: GND (brown)
PIN7: RTS (white)
PIN8: CTS (yellow)

7.3	 RS485
7.3.a	 Using RS485 / COM2 on terminal M1

DIP2 (DIP1 for TD410 with switch 5/6 ONLY for 
internal use)

456 3 2 1

O
N

O
FF

RS485 MASTER:
Termination 330Ω Polarization 
470Ω

456 3 2 1

O
N

O
FF RS485 MASTER:

Polarization only 470Ω

456 3 2 1

O
N

O
FF

RS485 SLAVE

PIN3: B+ (green)
PIN4: A- (yellow)
PIN5: GND (brown)
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7.3.b	 Using RS485 / COM2* MASTER on DB9 (Not available for TD410 and -EL versions)

4 3 2 1

O
N

O
FF

DIP2: 2,3,4 set to OFF
To use termination resistor on DB9, 
short-circuit pin 3 with 4 and 8 with 9 
on DB9 for MASTER mode

1

59

6

COM2   RS485

EARTHPin 5 : C

Pin 8

Pin 7 : 5Vi

Pin 3
470 Ω

470 Ω

330 Ω

B+

A-

MASTER
1 - Input
2 - C
3  
4     
5 - C
7 - 5V
8
9

Note: 5V Is isolated and can supply 70mA max

*	 Using the DB9 connector it is possible to introduce termination resistances using DIP2 as for terminal M1 or short-circuiting terminals 3-4 e 8-9, as showed 
in the figure.

7.3.c	 Using RS485 / COM2 SLAVE on DB9 (Not available for TD410 and -EL versions)

4 3 2 1

O
N

O
FF

DIP2: 2,3,4 set to OFF
Make sure about this setting for DIP2 
for SLAVE mode.
No short-circuit on DB9

1 - Input
2 - C
3 -  
4 - A-
5 - C
7 - 5V 
8 -  
9 - B+

1

59

6

Pin 5 : C

Pin 8

Pin 7 : 5Vi

Pin 3
470 Ω

470 Ω

330 Ω

SLAVE
COM2   RS485

EARTH
Note: 5V Is isolated and can supply 70mA max

7.4	 USB interfaces
HMI comes equipped with a USB 2.0 (Universal Serial Bus) host controller with multiple USB interfaces 
accessible externally for the user. This interface is not available on -EL models.

Warning! Peripheral USB devices can be connected to the USB interfaces on this device. Due to the 
large number of USB devices available on the market, Pixsys cannot guarantee their performance.

Caution! Because this interface is designed according to general PC specifications, extreme care 
should be exercised with regard to EMC, cable routing, etc.

Type USB 2.0
Design Type A
Transfer rate Low speed (1.5 Mbit/s), Full speed (12 Mbit/s), High speed (480 Mbit/s)
Current-carrying capacity Max. 0,8 A (total of all USB ports)
Cable length Max. 3 m (without hub)
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8 Ethernet interface
8.1 Technical data
This Ethernet controller is connected to external devices via the system unit.
Ethernet 1 interface (ETH1) TD410-AD / TD710-AD and -L TD810-AD / TD820-AD / TD830-AD
Number of ports 1 2
Controller LAN8710A
Cabling S/STP (Cat 5e)

Transfer rate 10/100 Mbit/s
10/100 Mbit/s ETH1-ETH2 to CPU 
Link
10/100/1000 Mbit/s ETH1-ETH2 link

Cable length Max. 100 m (min. Cat 5e)
LED

Green Link On = Gigabit connection
Off  = 10/100 Mbit connection

Yellow 10/100 Mbit Activity On =Link
Blink = Activity (data transfer)

9 Internal ethernet Switch (only TD810-TD820-TD830)
Two Ethernet 10/100/1000 Mbit ports on the rear side of the 
operator panel are available. ETH1 and ETH2 are internally 
connected to CPU through a Gigabit switch.
Thanks to dual port it is possible to make daisy-chain of more 
devices without using external ethernet switches.
Using VLAN system option, each port can be used as 
separated network interface. See TDControl user manual for 
more details.
For TD410 and TD710 only one Ethernet port is available.

LAPTOP

10 Battery
10.1 Internal battery replacement
BIOS and clock store data also in case of power failure thanks to a CR2032 battery placed on the side. 
To replace the battery it is necessary to remove the protection and pull out the extraction box using 
a blade screwdriver on models TD410/TD710 or by dedicated battery compartment on TD810 and 
greaters.
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10.2	 Battery detail
Classification Lithium Coin
Chemical System Lithium / Manganese Dioxide (Li/MnO2)
Nominal Voltage 3.0 Volts
Typical Capacity 235 mAh (to 2.0 volts)
Typical (Li) Content 0.109 grams (0.0038 oz.)
Energy Density 198 milliwatt hr/g, 653 milliwatt hr/cc
Operating Temp -30C to 60C

Warning! CR2032 is a “Lithium Coin” battery

Danger! KEEP OUT OF REACH OF CHILDREN. Swallowing may lead to serious injury or death in as little 
as 2 hours due to chemical burns and potential perforation of the esophagus. To prevent children 
from removing batteries, battery compartments is designed to be opened with a screwdriver and is 
protected by a security label.

Warning! It is suggested to replace the battery every 3 years. When the battery is removed, an 
internal dedicated device allows replacement without data loss if operation is completed within 1 
hour since battery removal.

11	 TdControlPanel

At switch-on a project starts allowing to verify the machine 
general status, date/system hour, related IP address, 
SoftPLC execution in background.

Using a VNC client you can view from your PC what is displayed on the PLC / HMI. Starting a browser 
with active Java service it is possibile to test if the device Webserver function is active. For this function 
it is necessary to use Internet Explorer.

Press “Td Control Panel,” to access the device control 
panel and verify/configure all the services and projects 
to be launched at starting. It is possible also to configure 
the standby time for the backlighting switch off  and the 
buzzer at display pressure.

The following paragraphs describe each function of the TdControlPanel windows. 

NB: Pictures show device standard configuration.
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11.a	 WIN EXPLORER

From this window it is possible to choose a set of options to 
start Windows CE and execute TDControlPanel.
•	 The first option starts Windows CE with desktop.
•	 The second option allows TDControlPanel starting if , 

during the switch on , the key “Stop” is keep pressed .
•	 Enabling the third option it is possible to set a 

protection password to avoid that unauthorized users, 
keeping pressed “STOP” , access TDControlPanel 
settings..

“START WINDOWS DESKTOP” allows to start “Explorer.exe” to access Windows CE desktop.

11.b	 HMI_MOVICON

From this window it is possible to select which Movicon 11 
services/programs execute automatically at starting.

The functions of the Movicon scada are available in all 
HMI and in “WEB” version PL500 (PL500-335-1AD-WEB)

“START” activates manually the Movicon project (and the file upload service)

11.c	 PLC LOGICLAB
From this window it is possible to enable/disable the 
SoftPLC execution at starting. Selecting “RUN console 
DEBUG”, during the SoftPLC execution, the Debug window 
will be filled with real-time system events to verify possible 
anomalies.
NB: this function requires many device resources. It is 
suggested to keep it active only if there are problems 
during the software development. Disable this function at 
the end of the development phase.

“START” activates manually the SoftPLC project (and any debug window).

11.d	 LAN ETH1

From this window it is possible to modify the device 
network configuration parameters. Any modification will 
require a restart to be applied.

NB: to transfer the SoftPLC program and Movicon on the 
device, it must have a fixed address. It is not possible to 
operate in DHCP.

The HMI default IP address is 192.168.0.100
The PL500 default IP address is 192.168.0.99
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11.e	 BACKLIGHT - BUZZER
From this window it is possible to configure backlighting 
and buzzer parameters. Enabling “Always ON” the 
backlighting keeps always active. Otherwise, enter time 
value in seconds on “Backlight ON for..(sec)” to enable the 
switching off or the lamp attenuation.
The first two fields allows to select the lamp brightness 
percentage (100% = ON, 0%=OFF) during standard 
operation or standby.
“Buzzer frequency” allows to select the buzzer tone 
frequency (an higher frequency corresponds to a more 
acute tone). Select “Buzzer OFF” to deactivate the buzzer at 
touch.
“TEST” keys allow to test selected parameters before saving 
the configuration. 

11.f	 WINVNC

From this window it is possible to enable/disable the VNC 
remote Desktop service.  Press“START VNC” to activate 
manually this service. Press “START VNC_CONFIG” to access 
VNC configuration window and set the authentication 
system or modify access password. NB. Parameter 
modification is recommended to expert users, incorrect 
parameters modification will cause remote desktop service 
malfunctioning. Default password to access remote 
Desktop through VNC is “1234”.

11.g	 BACKUP-RESTORE
BACKUP of LogicLab and Movicon projects stored on HMI.

After downloading LogicLab and Movicon projects on HMI 
and after setting the HMI for their automatic execution at 
each starting, switch off the HMI and restart it keeping the 
STOP icon pressed.

TDControlPanel window will be opened

Insert a USB pen (FAT32 formatted) in one of the available 
USB ports.
Press BACKUP-RESTORE to access the utility for projects 
backup and device configuration
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This window allows to select backup options:
-	 PLC_LOGICLAB (RUNTIME PROJECT): for backup of LogicLab project and complete Runtime and 

also of the configuration completed in the window PLC_LOGICLAB (accessible from main window 
of TDControlPanel)

-	 HMI_MOVICON (PROJECT): for backup of single Movicon project and configuration completed in 
the window HMI_MOVICON (accessible from main window of TdControlPanel)

-	 HMI_MOVICON (RUNTIME): backup only for Runtime
-	 TdControlPanel (Configuration): for backup of complete configuration performed within different 

utilities accessible from main window of TdControlPanel. *Attention: this backup will include also 
the eventual Password for TdControl Panel if it has been set in WIN EXPLORER

-	 LAN (IP CONFIGURATION): for backup of network settings of HMI 
-	 BOOT SCREEN: for backup of background image visualized during system start up
Tick all boxes to obtain a complete backup of the settings and software projects stored on the HMI. 
This is useful and time-saving when requested to program multiple HMIs for same application.

Press BACKUP TO USB DISK to open USB memory 
connected to the device; it will be possible to select 
destination folder and name for backup file 8default file 
name will be date and time of backup creation)

Press OK to start backup (Hourglass will show up ).
A confirmation popup will advice when process will be 
completed. Press OK to close popup , press ESC , then the 
device may be switched off.

RESTORE procedure to restore LogicLab and Movicon projects on HMI.

To program a new HMI starting from an existing Backup 
keep pressing STOP icon during start up of the device

TDControlPanel window will be opened
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Insert the USB pen containg Backup files on one of the 
available USB ports.
Press BACKUP-RESTORE

Press RESTORE FROM USB DISK to open USB memory 
connected to the HMI and select the chosen backup file

Press OK to start Restore process (Hourglass will show up).
A confirmation popup will advice when process will be 
completed. Press OK to close popup, press ESC, then the 
device may be switched off.

From now on at each start the HMI will start the projects (and eventually the complete configuration 
if selected ) automatically.

12	 LogicLab Suite
LogicLab Suite is the Pixsys development environment for the programming of PLC series, PL500 and 
all Operator panels / PanelPC.
The suite is available for free download within “download area” of the website pixsys.net, no activation 
code is required (only registration). Supported by all 32/64bit Windows versions, starting from 
Windows XP SP3. Available both in English and Italian version. Once downloaded the setup file on 
the computer, start the installation and follow the standard procedure. The program can be activated 
through the icon ”LogicLab”  (on desktop) or from the menu “Start” > “PixsysSuite” > “LogicLab”.

12.a	 Language modification

To modify the visualization language it is 
necessary to open options window form the 
menu “File” > “Options”, go to “Language”, select 
“ITA - italiano” and press “Select”. Confirm with 
“OK” , close and re-open LogicLab to enable the 
modification.
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12.b	 Create - load a project

Open an exsisting project:
•	 With LogicLab opened, click on “Open 

project” or select one of the last projects 
form the list. 

•	 With LogicLab closed, enter on the project 
folder and select (double click) the chosen 
file (icon  and extension “.plcprj”).

Create a new project:
Press “New project”.
Enter the name of the new project and select 
the folder where the project files will be stored. 
Finally, select the device to be programmed.

Attention: selecting “respect capital/lowercase letters”, a variable which contains a capital letter 
will be  understood as different from another with the same name but with this letter lowercase. It 
is recommended to keep this selection disabled, to avoid any confusion during the drafting of the 
program code.

12.c	 Connection to target
Here below please find the necessary requirements for the correct connection between target  (device 
to be programmed) and the development environment on PC (LogicLab).
Target requirements:
•	 device ON and started
•	 configured with static IP address compatible with the network where there is the PC to which it will 

connect. By default, the IP address of the HMI is 192.168.0.100, for PL500 is 192.168.0.99, so the PC 
must have the same network and class (in this case 192.168.0.XXX) but different physical address 
(the last 3 digits of the IP address, with a number between 1 and 255, different from 100). If it is 
necessary to modify the IP address of the terminal, refer to the TD Control Panel configuration, 
section “LAN ETH1” on par. 10.d.

•	 connection with net cable (direct or cross) directly to PC or through a net switch
•	 SoftPLC in execution (refer to TD Control Panel configuration, section “PLC LOGICLAB” on par. 10.c).

PC requirements:
•	 IP address compatible with the network where it is located and with the IP address configured on 

the target (see previous points)
•	 antivirus/firewall which allows the connection to network devices (normally already correctly 

configured)
•	 LogicLab configured for the connection to the target to be programmed: menu “On Line” > “Select 

communication” , on the window that opens press “Properties” and than enter the target IP on “IP 
Address” , keeping all the rest unaltered. In case of very slow networks or of a network configuration 
with different switches, it is possibile to increase the “Timeout” value (expressed in mS).
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The image represents default configuration

Confirm all windows pressing “OK” and save through  or from the menu “file” > “SaveProject”.
To verify the correct LogicLab and Target configurations, it is possible to make the connection pressing 

 or form the menu “On Line” > “Connect”. If the connection is correctly done, the status bar at the 
lower right side will visualize “CONNECTED” and “NO CODE” (to indicate that the target is connected 
and has no code in it) or “DIFF CODE” (to indicate that the code which is being visualized does not 
correspond to those who lies in the target).

12.d	 Compiling and downloading the code
Once entered the project code it is necessary to verify eventual errors pressing F7, clicking on icon  
or from the menu “Project” > “Fill”.
If the compilation is correctly done it is possible to transfer the program to the target pressing F5, 
through icon  or from the menu “On Line” > “Code transferring”.
The status bar will show “CONNECTED” and “SOURCE OK” indicating that the program running on the 
target corresponds to that which is visualized on PC.

12.e	 Watch window
If the program running on the target corresponds to that which is being visualized on PC, the status 
bar will show “CONNECTED” and “SOURCE OK” and it is possible  to use the window “Watch” to verify 
real-time the status of the variables used in the project. To enable the window “Watch”, press CTRL+T 
or use “View” > “View tool window” > “Watch”. To add a variable to the window “Watch”, just drag it inside 
or press the icon  and select it manually.

From now on, the window “Watch” will visualize 
the value of the inserted variable, in real time.

Through  it is possible to save, load and add an exsisting watch-list to the list of variables. 
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To change the visualization format, it is 
necessary to select the variable and press .
On the window that opens, select the chosen 
format and confirm pressing “OK”.

13	 Interfacing Movicon 11 with LogicLab
NB: Movicon 11.5 or greater.

To execute only once:
Following steps are to be completed on the PC which will be used to develop the projects.
Go to download area of Pixsys website / Movicon section and download “MOVICON 11.6 Update-Ag-
giorna Driver.exe” corresponding to your PC system. Double click to launch the .exe file and follow 
instructions.
Do the same procedure also if a Panel PC (TD750-TD850-TD900-TD910-TD920) is used.
Note: with this procedure all PLC system variables and variables created and used in the PLC are 
imported.
The creation and  the updating of the PLC variables list is done only if the LogicLab program is 
compiled without errors and downloaded on the target.

13.a	 Creating a new Movicon project
Start the software and choose the platform “Windows® X86 / X64” for Panel-PC or “Windows® CE 
Platform” for HMI and for “WEB” version of PL500. If the new Movicon project is being created following 
the Wizard, at the end it will visualize the driver configuration window, switch to the section “Driver 
Configuration” to par. 12.b. If the driver is being installed manually, proceed as follow:

Add the communication driver with a 
right click on “Real time DB” and then “new 
communication driver”.

Select “Pixsys” from the manufacturer menu 
and then “Pixsys SoftPLC Driver”.

Confirm with “OK” and double click on the 
driver just created to open the configuration 
window.
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13.b	 Driver configuration

Select “Station” and add a new station pressing 
“ADD”.

1.	 Enter source path of the LogicLab project 
located on the PC used for development.  This 
allows to import variables, execute Movicon 
in preview mode on own PC, including 
communication with SoftPLC, and perform 
complete test. Next step is to indicate IP 
address of the target HMI/PC (only after 
completing development it will be necessary 
to enter localhost address 127.0.0.1 to enable 
communication of Movicon project with the 
softPLC of the panel itself.

2.	 This field is self-compiling after entering path as described on previous point. If using an HMI/PL500, 
do not modify the self-compiling field; if using a Panel PC (TD750, TD850 etc…) enter the path used 
for download of the LogicLab project (default D:\LLExec\ NameMyProjectLogicLab.sym.xml).

3.	 If Movicon project will be executed on the HMI/PC where the softPLC is also installed, then the IP 
address will be 127.0.0.1. If it will be executed on a different HMI/PC, then enter the IP address of the 
softPLC.

4.	 From the section “General” assign a name to the station, ex. “PLC”.

Press OK to save settings and exit.

Now it is possible to import the LogicLab 
project variabiles on Movicon.
Right click on “SoftPLC Pixsys” and select “Import 
PLC database”.

Press “Read from PLC project”, the list of all 
available variables will be provided.

Select variables to be imported and press 
“Import”.

NB: If importing an array variable, it will be visualized as a structure carrying the array name.
Single array members will be accessible individually with following syntax NameMyArray:NameMyArray 
_X where X is the array index (starting from 0).
Now variables are available on the Movicon project. If it is necessary to import new variables (to modify 
LogicLab project), repeat only the reading and import variables procedure.
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13.c	 Downloading the Movicon code to the target
To downlaod the Movicon Project, use the icon: 

1.	 Select the protocol used to transfer the code: 
TCP

2.	 Insert the target IP address (default for HMI/PLC: 
192.168.0.100).

3.	 If using an HMI/PLC leave the field blank, if using 
a Panel-PC insert user (or the user name that is 
logged on the Panel-PC target).

4.	 If using an HMI/PLC leave the field blank, if using 
a Panel-PC insert 123456

5.	 If using an HMI/PLC insert \NandFlash\MyMovi-
conProjectName\, if using a Panel-PC insert D:\
MyMoviconProjectName\. In this way Movicon will 
create a folder named MyMoviconProjectName 
and it will download all the project files into it.

6.	 Press “Upload Project!“ to download the project 
files to the target (press “Yes to All“ if a project 
was already downloaded to overwrite the old 
files).

7.	 Once the download is completed, press “Start 
Deviec Project“ to launch the execution of the 
project in the target (the project in execution 
will be closed and the new one will be executed).

NB: if you need to trasfer different projects/versions to the target, you can change the destination 
folder (you must mantain the first part of the address \NandFlash\). 
Using the TdControlPanel is possible to select which Movicon 11 project will be executed automatically 
at starting (see paragraph  10.b).

14	 Simulation of the whole project SoftPLC + SCADA
From LogicLab, launch the simulator through the icon  or from menu “Debug” > “Simulation mode”. 
On the window which appears, create a new working area indicating the name and the destination 
folder (by default it is selected the folder where the project risiede).
At this point, the simulator will be activated and connected (status window shows “CONNECTED”) but 
without the code (status window shows “NO CODE”), transfer the code pressing F5, through the icon 

 or from the menu “Online” > “Online download code”.
Verify that the status bar visualize“CONNECTED” and “SOURCE OK”. If “NO CODE is still visualized, restart 
the simulator pressing  or from the menu “On-line” > “Target reboot”. 
On Movicon, entering the Pixsys driver configurator and configure as follows:

1.	 Enter the folder where the LogicLab 
project resides and select the file 
NameMyProjectLogicLab.sym.xml

2.	 Enter the folder where the simulator is 
operating, set as filter “All files (*.*) and 
select the file NameMyProjectLogicLab.
sym.simul. Pay attention to the file 
exstension, into the project folder there 
are many files with the same name but 
different extension.

3.	 Select the localhost address: 127.0.0.1
4.	 From the section “General” assign a 

name to the station, ex. “PLC”.
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At this point, to start the simulation of the graphic interface connected to the simulator (which is 
already executing the code previously downloaded), press Alt+F12, the icon  or from the menu “File” 
> “Start Project”.
To end the simulation, press Alt+F12 or the icon  on the bar which appears on the upper side.

Warranty terms
Pixsys srl warrants its electronic devices for 12 months from Invoice date. Pixsys liability shall be limited 
to repairing (or replacing at its option) any defective product which is returned with RMA (Return 
Material Authorization) priorly obtained on Pixsys website and to be clearly marked on documents. 
Pixsys shall not be responsible for accident, neglect, misuse, damage to objects or people caused 
using the devices outside their specifications or outside any published performance data, including 
unauthorized and unqualified repairing or failure to provide proper environmental conditions. In no 
event shall Pixsys liability exceed the purchase price of the product(s).
Warranty does not cover any damage arising from post-sale installation of software applications and 
specifically any damage caused by malware. Technical assistance by Pixsys which should be required 
to restore OS will be subject to assistance fee prevailing at time of request.

Notes / Updates



User manual - HMI Series - 23



24 - HMI Series - Manuale d’uso

1	 Norme di sicurezza
Le indicazioni di questo manuale sono riferite a prodotti Pixsys quali i dispositivi logici programmabili 
(PLC) e i dispositivi di controllo e monitoraggio (PC industriali, HMI) da ora in poi identificati 
semplicemente con il termine “Il dispositivo” o “i dispositivi”. I dispositivi realizzati e commercializzati 
da Pixsys sono progettati, sviluppati e realizzati per un uso convenzionale in ambienti industriali. Non 
sono stati progettati, sviluppati e realizzati per qualsiasi altro uso che possa comportare gravi rischi 
o pericoli quali decesso, lesioni, gravi danni fisici senza che siano adottati rigorosi sistemi di sicurezza 
indipendenti dal dispositivo. In particolare, tali rischi e pericoli includono l’uso di questi dispositivi per 
monitorare le reazioni nucleari nelle centrali, il loro uso nei sistemi di controllo o sicurezza del volo, 
nonché nel controllo di sistemi di trasporto di massa, supporto a sistemi salvavita medicali o sistemi 
d’armamento.

1.1	 Regolamenti e procedure
I dispositivi elettronici non sono mai completamente sicuri. Se il dispositivo viene meno al suo 
funzionamento, l’utente è responsabile di garantire che altri dispositivi connessi, ad es. motori, 
siano portati in una condizione di sicurezza. Le precauzioni di sicurezza inerenti i sistemi di controllo 
industriale devono essere adottate in conformità alle normative nazionali e internazionali applicabili 
quando si utilizzano i dispositivi come sistemi di controllo insieme a Soft-PLC. Lo stesso vale per tutti 
gli altri dispositivi collegati al sistema. Tutte le operazioni come l’installazione, la messa in servizio e la 
manutenzione dei dispositivi devono essere eseguite solo da personale qualificato.
Il personale qualificato deve avere familiarità con il trasporto, montaggio, installazione, messa in 
servizio e funzionamento dei dispositivi ed avere le previste qualifiche ad operare (ad esempio IEC 
60364). È necessario osservare le norme nazionali sulla prevenzione degli incidenti.
Le avvertenze di sicurezza, le informazioni sulle condizioni di collegamento (etichette e documenta-
zione) e i valori limite specificati nei dati tecnici devono essere letti attentamente prima dell’installa-
zione e della messa in servizio e devono essere sempre osservati.

1.2	 Linee guida per l’installazione
•	 Questi dispositivi non sono pronti per l’uso al momento della consegna, devono essere installati 

e cablati secondo le indicazioni specifiche di questa documentazione al fine di rispettarne i limiti 
EMC e gli standard di sicurezza.

•	 L’installazione deve essere eseguita secondo questa documentazione utilizzando attrezzature e 
strumenti adeguati.

•	 I dispositivi devono essere installati solo da personale qualificato senza tensione applicata. Prima 
dell’installazione, la tensione all’armadio elettrico deve essere spenta e ne deve essere impedita 
l’accensione per tutto il tempo dell’intervento.

•	 Devono essere osservate le linee guida generali sulla sicurezza e le norme nazionali sulla 
prevenzione degli incidenti.

•	 L’installazione elettrica deve essere eseguita in conformità alle linee guida applicabili (ad esempio 
sezioni trasversali della linea, fusibili, collegamenti di terra protettivi).

1.3	 Virus e programmi pericolosi
Questo sistema è soggetto a potenziali rischi ogni volta che i dati vengono scambiati o il software 
viene installato da un supporto dati (ad esempio CD-ROM o flash-disk USB), una connessione di 
rete o Internet. L’utente è responsabile della valutazione di questi pericoli, implementando misure 
preventive come programmi di protezione antivirus, firewall, ecc. e assicurandosi che il software sia 
ottenuto solo da fonti attendibili.

Indice degli argomenti
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1.4	 Organizzazione delle note di sicurezza
Le note sulla sicurezza in questo manuale sono organizzate come segue:
Note di sicurezza Descrizione

Danger! La mancata osservanza di queste linee guida e avvisi di sicurezza può essere 
potenzialmente mortale.

Warning! La mancata osservanza di queste linee guida e avvisi di sicurezza può comportare 
lesioni gravi o danni sostanziali alla proprietà.

Caution! La mancata osservanza di queste linee guida e avvisi di sicurezza può provocare 
lesioni o danni alle cose.

Information! Tali informazioni sono importanti per prevenire errori.

2	 Spazi per la circolazione dell’aria e la ventilazione
Per garantire una circolazione sufficiente dell’aria lasciare 5 cm di spazio vuoto sopra, sotto, di lato 
e dietro il dispositivo. Nessuna altra ventilazione del sistema è richiesta. Il pannello operatore è 
autoventilato e omologato per il montaggio inclinato con angoli fino a ± 35° in armadi fissi.

Information! Se è necessario spazio aggiuntivo per operare o mantenere il dispositivo, questo deve 
essere preso in considerazione durante l’installazione.

Caution! Le specifiche di spazio per la circolazione dell’aria si basano sullo scenario peggiore di 
funzionamento. La temperatura ambiente massima specificata non deve essere superata!

Caution! Un’installazione inclinata riduce la convezione del pannello operatore e quindi la 
temperatura ambiente massima consentita per operazione che dovrà essere valutata assieme al 
supporto tecnico Pixsys.

3	 Installazione del dispositivo
Il pannello del dispositivo è installato nel foro sul pannello macchina utilizzando i ganci in plastica 
forniti seguendo le indicazioni di figure 1 e 2.
Il numero di ganci in plastica forniti dipende dal pannello da installare. Lo spessore della parete o della 
piastra da forare per installare il dispositivo deve essere compresa tra 1 mm e 5 mm. È necessario un 
cacciavite Phillips ISO 7045 (ex UNI 7687 DIN 7985A) per serrare o allentare le viti dei ganci di fissaggio. 
La coppia di serraggio massima per i ganci di fissaggio è di 0,5 Nm. I dispositivi devono essere installati 
su una superficie piana, pulita e senza sbavature; aree irregolari possono danneggiare il display 
quando le viti sono serrate o permettere l’intrusione di polvere e acqua.
Dima foratura (cut-out) Fig. 1 Fig. 2

Lc (± 0,5 mm)

Hc (± 0,5 mm)
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Dimensioni

Suggested thickness
Spessore suggerito
2 ÷ 8 mm

Suggested thickness
Spessore suggerito
2 ÷ 8 mm

TDXXX

LW

Wc

Hc

H

Lc
Suggested thickness

Spessore suggerito
2÷8 mm

Modelli L H W * Wc * Lc Hc
TD410-AD 140 100 36 30 130 89
TD710-AD 204 160 41 35 181 144
TD810-AD 274 216 40 31 260 200
TD820-AD 317 256 42 33 302 242
TD830-AD 406 270 50 41 391 255

*	 Le dimensioni indicate si riferiscono al solo prodotto senza l’ingombro dei morsetti e dei cavi.

4	 Alimentazione e messa a terra dello strumento
Danger! Questo dispositivo può essere alimentato solo da una 
sorgente di  alimentazione SELV / PELV (classe 2) o in classe di 
sicurezza per bassissima tensione (SELV) secondo EN 60950.

Collegare una sorgente di alimentazione a 24VDC 1,0A (min.) come 
nella figura accanto. Collegare la presa di TERRA dello strumento 
con un conduttore di sezione minima 18AWG (2,5mmq). Per tutta 
la gamma di strumenti si consiglia l’utilizzo di un alimentatore 
dedicato da almeno 24 VDC 1,0A 24VA, vedere codice 2700.10.008.
Utilizzare fili in rame, alluminio rivestito in rame o alluminio per tutti 
i collegamenti elettrici.

Caution! La linea di alimentazione 24 VDC deve essere protetta da 
un fusibile da 2,5 A.
Caution! I collegamenti di massa devono essere il più corti possibili 
ed eseguiti con filo con la sezione massima possibile verso il punto 
centrale di messa a terra (ad esempio l’armadio o il sistema di 
controllo).
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5	 Collegamenti elettrici
Il device è stato progettato e costruito in conformità alle Direttive Bassa Tensione 2006/95/CE, 2014/35/
UE (LVD) e Compatibilità elettromagnetica 2004/108/CE e 2014/30/UE (EMC). Per l’installazione in 
ambienti industriali è buona norma seguire la seguenti precauzioni:
•	 Distinguere la linea di alimentazioni da quelle di potenza.
•	 Evitare la vicinanza di gruppi di teleruttori, contattori elettromagnetici, motori di grossa potenza e 

comunque usare appositi filtri.
•	 Evitare la vicinanza di gruppi di potenza, in particolare se a controllo di fase.
•	 Si raccomanda l’impiego di filtri di rete sull’alimentazione della macchina in cui lo strumento 

verrà installato, in particolare nel caso di alimentazione 230 VAC. Si evidenzia che il regolatore è 
concepito per essere assemblato ad altre macchine e dunque la marcatura CE del regolatore non 
esime il costruttore dell’impianto dagli obblighi di sicurezza e conformità previsti per la macchina 
nel suo complesso.

6	 Dati tecnici
6.1	 Caratteristiche generali

TD410-AD * TD710-AD ** TD810-AD TD820-AD TD830-AD
Tensione alimentazione 12 ÷ 24 VDC ± 10%
Consumo (utilizzo tipico con 
2 device USB) 7.5VA 13VA 16VA 15VA 20VA

Range temperatura 0...50°C
Range umidità 10...90% (senza condensa)

*	 disponibile versione entry level (-EL) senza porte USB, connettori DB9 (RS232 e RS485), CAN e porta Ethernet.

*	 disponibile versione entry level (-EL) senza porte USB, connettori DB9 (RS232 e RS485) e porta CAN.

6.2	 Caratteristiche hardware
CPU ARM® CORTEX™ - A8 @1.0GHz
RAM 512 MB DDR3
eMMC 4GB

6.3	 LCD touch: 4 fili resistivo
TD410-AD TD710-AD TD810-AD TD820-AD TD830-AD

Risoluzione 4.3” TFT
480 x 272

7” TFT 
800 x 480

10” TFT 
800 x 600

12” TFT 
1280 x 800 

15,6” TFT 
1366 x 768 

Colori 65K (16 bit) 65K (16 bit) 65K (16 bit) 65K (16 bit) 65K (16 bit) 
Retroilluminazione LED 400 cd/m2 LED 280 cd/m2 LED 320 cd/m2 LED 220 cd/m2 LED 300 cd/m2
Durata 
retroilluminazione* 50000 h Typ @ 25°C** 30000 h Typ @ 25°C** 50000 h Typ @ 

25°C**
Lifetime** 17 10 17

*	 Riduzione luminosità all’80% del dato di fabbrica  /  **	 Anni di funzionamento per 8 ore / giorno
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7	 Interfacce di comunicazione
TD410-AD TD710-AD*** - TD810-AD*** - TD820-AD - TD830-AD

***	 ETH2 non disponibile su questi modelli.

7.1	 CANopen
7.1.a	 Utilizzo CAN / EXP1 su morsetto M1 (Non disponibile su versioni -EL)

456 3 2 1

O
N

O
FF

DIP2 (DIP1 per TD410 con switch 5 
e 6 SOLO per uso interno)
EXP1/CAN con terminazione 120Ω

PIN5: GND (marrone)
PIN6: CANH (blu)
PIN7: CANL (bianco)

7.2	 RS232
7.2.a	 Utilizzo RS232 / COM1 su DB9 (Non disponibile per TD410 e versioni -EL)

Connessione RS232 base:
PIN2: RX (verde)
PIN3: TX (blu)
PIN5: GND (marrone)

Connessione RS232 con RTS / CTS:
PIN2: RX (verde)
PIN3: TX (blu)
PIN5: GND (marrone)
PIN7: RTS (bianco)
PIN8: CTS (giallo)
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7.3	 RS485
7.3.a	 Utilizzo RS485 / COM2 su morsetto M1

DIP2 (DIP1 per TD410 con switch 5 e 6 SOLO per 
uso interno)

456 3 2 1

O
N

O
FF

RS485 MASTER:
Terminatore 330Ω Polarizzatore 
470Ω

456 3 2 1

O
N

O
FF RS485 MASTER:

Solo polarizzatore 470Ω

456 3 2 1

O
N

O
FF

RS485 SLAVE

PIN3: B+ (verde)
PIN4: A- (giallo)
PIN5: GND (marrone)

7.3.b	 Utilizzo RS485 / COM2* MASTER su DB9 (Non disponibile per TD410 e versioni -EL)

4 3 2 1

O
N

O
FF

DIP2: 2,3,4 in OFF
Per poter usare il terminatore su DB9, 
circuitare pin 3 con 4 e 8 con 9 su DB9 
per modalità MASTER

1

59

6

COM2   RS485

EARTHPin 5 : C

Pin 8

Pin 7 : 5Vi

Pin 3
470 Ω

470 Ω

330 Ω

B+

A-

MASTER
1 - Input
2 - C
3  
4     
5 - C
7 - 5V
8
9

Note: 5V Is isolated and can supply 70mA max

*	 Utilizzando il connettore DB9 si possono inserire le resistenze di terminazione utilizzando DIP2 come per il morsetto M1 
oppure ponticellando, come visibile in figura, i contatti 3-4 e 8-9.

7.3.c	 Utilizzo RS485 / COM2 SLAVE su DB9 (Non disponibile per TD410 e versioni -EL)

4 3 2 1

O
N

O
FF

DIP2: 2,3,4 in OFF
Assicurarsi che il DIP2 sia così 
configurato per la modalità SLAVE e 
non siano presenti ponticelli su DB9

1 - Input
2 - C
3 -  
4 - A-
5 - C
7 - 5V 
8 -  
9 - B+

1

59

6

Pin 5 : C

Pin 8

Pin 7 : 5Vi

Pin 3
470 Ω

470 Ω

330 Ω

SLAVE
COM2   RS485

EARTH
Note: 5V Is isolated and can supply 70mA max
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7.4 Interfaccia USB
L’HMI è dotato di un controller host USB 2.0 (Universal Serial Bus) con più interfacce USB, una anteriore 
e due posteriori accessibili esternamente dall’utente. Interfaccia non presente sulle versioni -EL.

Warning! Diff erenti dispositivi USB possono essere collegati alle interfacce USB su questo dispositivo. 
A causa dell’elevato numero di dispositivi USB disponibili sul mercato, Pixsys non può garantire le 
loro performance.
Caution! Poiché questa interfaccia è progettata in base a specifi che generali del settore PC, è 
necessario prestare la massima attenzione per quanto riguarda EMC, cablaggi, ecc.

Tipo USB 2.0
Tipologia del connettore Type A
Transfer rate Low speed (1.5 Mbit/s), Full speed (12 Mbit/s), High speed (480 Mbit/s)
Massima corrente erogabile Max. 0,8 A (totale di tutte e 3 le porte USB)
Lunghezza cavo Max. 3 m (senza hub)

8 Interfaccia Ethernet
8.1 Dati tecnici
Questo controller Ethernet è collegato a dispositivi esterni tramite l’unità di sistema.
Interfaccia Ethernet 1 (ETH1) TD410-AD / TD710-AD e -L TD810-AD / TD820-AD / TD830-AD
Numero di porte 1 2
Controller LAN8710A
Cablaggio S/STP (Cat 5e)

Transfer rate 10/100 Mbit/s
10/100 Mbit/s ETH1-ETH2 to CPU 
Link
10/100/1000 Mbit/s ETH1-ETH2 link

Lunghezza cavo Max. 100 m (min. Cat 5e)
LED

Verde Link On = Connessione Gigabit
Off  = Connessione 10/100 Mbit

Giallo 10/100 Mbit Activity On =Link
Lampeggio = Activity (trasferim. dati)

9 Switch ethernet interno (solo TD810-TD820-TD830)
Sono disponibili due porte Ethernet 10/100/1000 Mbit sul retro 
del pannello operatore. ETH1 e ETH2 sono collegati internamente 
alla CPU tramite uno switch Gigabit. Grazie alla doppia porta 
è possibile realizzare una connessione di tipo daisy-chain (o a 
cascata) di più dispositivi senza utilizzare switch Ethernet esterni.
Utilizzando l’opzione di sistema VLAN, ciascuna porta può essere 
utilizzata come interfaccia di rete separata. Vedere il manuale 
utente TDControl per ulteriori dettagli.
Nei TD410 e TD710 è presente solo 1 porta Ethernet.

LAPTOP
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10	 Batteria
10.1	 Sostituzione batteria tampone interna
Il BIOS e l’orologio di sistema mantengono le loro funzionalità in assenza di rete grazie ad una batteria 
CR2032 accessibile dal lato del terminale. Per la sostituzione, occorre rimuovere l’adesivo di protezione 
e sfilare il porta batterie con un cacciavite a lama come in figura nei modelli TD410/TD710, mentre per 
modelli TD810 e superiori si effettua tramite l’apposito sportellino.

10.2	 Dettagli della batteria
Tipologia Batteria Litio CR2032
Composizione chimica Lithium / Manganese Dioxide (Li/MnO2)
Tensione Nominale 3.0 Volts
Capacità 235 mAh (fino a 2.0 volts)
Contenuto tipico di Litio (Li) 0.109 gr. (0.0038 oz.)
Densità di energia 198 milliwatt hr/g, 653 milliwatt hr/cc
Temperatura di utilizzo -30C a 60C

Warning! CR2032 è una batteria al litio (Li) “a bottone”.
Danger! TENERE FUORI DALLA PORTATA DEI BAMBINI. La deglutizione può portare a lesioni gravi 
o morte in meno di 2 ore a causa di ustioni chimiche e potenziale perforazione dell’esofago. Per 
evitare che i bambini rimuovano le batterie, il vano batteria è progettato per essere aperto con un 
cacciavite ed è protetto da un’etichetta di sicurezza.
Warning! Si consiglia di sostituire la batteria ogni 3 anni. Quando la batteria viene rimossa, un 
dispositivo interno dedicato consente la sostituzione
senza perdita di dati se l’operazione è completata entro 1 ora dalla rimozione della batteria.

11	 TdControlPanel

All’avvio del dispositivo si apre un progetto che consente 
di verificare lo stato generale della macchina, data e ora di 
sistema, indirizzo IP associato, esecuzione del SoftPLC in 
background.

Utilizzando un client VNC è possibile visualizzare dal proprio PC quello che viene visualizzato a video 
sul PLC/HMI. Avviando un browser con servizio Java attivo è inoltre possibile testare se la funzione di 
Webserver del dispositivo è attiva. Per questa funzione è necessario l’uso del browser Internet Explorer.
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Dal pulsante “Td Control Panel,” si accede al pannello 
di controllo del dispositivo, dove è possibile verificare e 
configurare i vari servizi e progetti da lanciare all’avvio, 
oltre a poter configurare il tempo di attesa per lo 
spegnimento della retroilluminazione, il buzzer al tocco del 
display ecc.

Nei paragrafi seguenti verrà descritta ciascuna funzione delle finestre presenti nel TdControlPanel.
NB: Le foto mostrano la configurazione di default del dispositivo.

11.a	 WIN EXPLORER
Da questa finestra è possibile scegliere un set di opzioni 
delle modalità di avvio di Windows CE ed esecuzione di 
TDControlPanel.
•	 La prima opzione avvia Windows CE con desktop.
•	 La seconda opzione permette l’avvio del TDControl-

Panel se, durante l’avvio del terminale, si mantiene 
premuto il pulsante “Stop” .

•	 Abilitando la terza opzione sarà possibile impostare 
una password di protezione per evitare che utenti non 
autorizzati, tenendo premuto il pulsante di “STOP” , 
accedano alle impostazioni del TDControlPanel.

Il pulsante “START WINDOWS DESKTOP” permette di avviare il servizio “Explorer.exe” e quindi di 
accedere al desktop di Windows CE.

11.b	 HMI_MOVICON

Da questa finestra è possibile selezionare quali servizi e 
programmi relativi a Movicon 11 eseguire in automatico 
all’avvio del dispositivo.

Le funzionalità dello scada Movicon sono disponibili in 
tutti gli HMI e nel PL500 nella versione “WEB” (PL500-
335-1AD-WEB)

Il pulsante “START” avvia il progetto Movicon (ed il servizio di upload file) manualmente.

11.c	 PLC LOGICLAB
Da questa finestra si abilita/disabilita l’esecuzione del 
SoftPLC all’avvio del dispositivo. Selezionando il flag “RUN 
console DEBUG”, durante l’esecuzione del SoftPLC, la finestra 
di Debug sarà compilata con gli eventi di sistema in tempo 
reale per poter verificare eventuali anomalie.
NB: questa funzione richiede molte risorse al dispositivo. 
Si consiglia di mantenerla attiva solo se si riscontrano 
problemi durante lo sviluppo del software. È bene 
disabilitarla al termine della fase di sviluppo!

Il pulsante “START” avvia il progetto SoftPLC (e l’eventuale finestra di debug) manualmente.
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11.d	 LAN ETH1

Da questa finestra è possibile modificare i parametri della 
configurazione di rete del dispositivo. Eventuali modifiche 
richiedono un riavvio per essere applicate.

NB: affinché si possa trasferire il programma SoftPLC e 
Movicon sul dispositivo, questo deve avere un indirizzo 
fisso, non è possibile lavorare in DHCP.

L’indirizzo IP di default degli HMI è 192.168.0.100
L’indirizzo IP di default del PL500 è 192.168.0.99

11.e	 BACKLIGHT - BUZZER
Da questa finestra è possibile configurare i parametri 
relativi la retroilluminazione e il buzzer. Abilitando la 
funzione “Always ON” la retroilluminazione resta sempre 
attiva, nel caso contrario nel terzo campo “Backlight ON 
for..(sec)” si dovrà inserire il tempo in secondi per avviare 
lo spegnimento o l’attenuazione della lampada. Nel 1° e 2° 
campo si possono impostare: la percentuale di accensione 
della lampada (100% = accesa, 0%=spento) nello stato di 
lavoro normale o nello stato di standby. Il quarto campo 
“Buzzer frequency” permette di impostare la frequenza del 
suono del buzzer più la frequenza è alta più il suono sarà 
acuto. Il flag “Buzzer OFF” disabilita il buzzer al tocco del 
touch. I pulsanti “TEST” permettono di testare i parametri 
impostati prima di salvare la configurazione.

11.f	 WINVNC

Da questa finestra si abilita/disabilita il servizio di Desktop 
remoto di VNC. Il pulsante “START VNC” abilita manualmente 
tale servizio. Il pulsante “START VNC_CONFIG” apre la 
finestra di configurazione di VNC per poter impostare il 
sistema di autenticazione, cambiare la password di accesso 
ecc. Attenzione la modifica dei parametri è consigliata per 
utenti avanzati, la manomissione dei parametri in modo 
errato provocherà il malfunzionamento del servizio di 
desktop remoto. La password di default per l’accesso al 
Desktop remoto del dispositivo via VNC è “1234”.

11.g	 BACKUP-RESTORE
BACKUP: procedura per eseguire il backup (caricamento da HMI) dei progetti LogicLab e Movicon.

Una volta scaricati i progetti LogicLab e Movicon sul 
dispositivo e configurato quest’ultimo in modo da eseguirli 
ad ogni accensione, spegnere e riaccendere il dispositivo 
tenendo premuto il simbolo di “STOP”
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In questo modo si avvia la finestra del TDControlPanel

A questo punto inserire una penna USB, formattata in 
FAT32, su una delle porte USB disponibili.
Premere “BACKUP-RESTORE” per accedere all’utility che 
permette il backup dei progetti e della configurazione del 
dispositivo.

Da questa finestra si può scegliere di quali risorse effettuare il backup:
-	 PLC_LOGICLAB (RUNTIME-PROJECT): esegue il backup del progetto LogicLab (e dell’intero 

Runtime), oltre che della configurazione effettuata nella finestra “PLC_LOGICLAB” (accessibile dalla 
finestra principale del TDControlPanel). 

-	 HMI_MOVICON(PROJECT): esegue il backup del solo progetto Movicon, oltre che della configura-
zione effettuata nella finestra “HMI_MOVICON” (accessibile dalla finestra principale del TDControl-
Panel).

-	 HMI_MOVICON (RUNTIME): esegue il backup del solo Runtime
-	 TdControlPanel (Configuration): esegue il backup dell’intera configurazione effettuata nelle varie 

utility accessibili dalla finestra principale del TdControlPanel. NB: In questo modo si effettua il 
backup anche dell’eventuale password di accesso al TdControlPanel, se impostata dalla finestra 
“WIN EXPLORER”.

-	 LAN (IP CONFIGURATION): esegue il backup della configurazione di rete del dispositivo.
-	 BOOT SCREEN: esegue il backup dell’immagine di sfondo che si visualizza durante l’avvio del 

sistema.
Abilitando tutte le spunte, si ottiene un backup completo della configurazione e dei software presenti 
nel dispositivo, utile per velocizzare la programmazione in serie di più pannelli operatore.

Premendo il tasto “BACKUP TO USB DISK” verrà aperta 
la memoria USB collegata al terminale e sarà possibile 
selezionare una cartella di destinazione ed il nome del file 
di backup (il nome predefinito del file sarà la data e l’ora di 
creazione di questo).

Premendo “OK” la procedura di backup inizia (si vedrà una 
clessidra al centro dello schermo). 
Un popup di conferma indica il termine della procedura. 
Premendo “OK” si chiude il popup ed è quindi possibile 
premere “ESC” e poi spegnere il dispositivo.
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RESTORE: procedura per eseguire il ripristino (caricamento su HMI) dei progetti LogicLab e Movicon.

Per effettuare la programmazione di un nuovo dispositivo 
a partire da un backup, tenere premuto il simbolo di “STOP” 
in fase di accensione.

In questo modo si avvia la finestra del TDControlPanel

A questo punto inserire la penna USB contenente il Backup 
su una delle porte USB disponibili.
Premere “BACKUP-RESTORE” per accedere all’utility che 
permette il ripristino dei progetti e della configurazione del 
dispositivo.

Premendo il tasto “RESTORE FROM USB DISK” verrà aperta 
la memoria USB collegata al terminale e sarà possibile 
selezionare il file di backup creato precedentemente.

Premendo “OK” la procedura di restore inizia (si vedrà una 
clessidra al centro dello schermo). 
Un popup di conferma indica il termine della procedura. 
Premendo “OK” si chiude il popup ed è quindi possibile 
premere “ESC” e poi spegnere il dispositivo.

Da questo momento, ad ogni accensione il dispositivo avvierà i progetti (e l’intera configurazione se 
selezionata durante la fase di backup) automaticamente.
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12	 Suite LogicLab
La Suite LogicLab è l’ambiente di sviluppo di Pixsys per la programmazione del PLC PL500 e di tutta la 
famiglia di terminali operatore e PanelPC.
La suite è scaricabile dall’area download del sito pixsys.net, previa registrazione e non necessita di 
codici di attivazione. È compatibile con tutte le versioni di Windows 32/64bit a partire da Windows 
XP SP3 ed è disponibile in lingua inglese e in italiano. Una volta scaricato il file di setup sul proprio 
computer, avviare l’installazione e seguire la procedura standard. Una volta installato il programma, 
si avvia tramite l’icona ”LogicLab”  sul desktop oppure dal menù “Start” > “PixsysSuite” > “LogicLab”.

12.a	 Cambio lingua

Per cambiare la lingua di visualizzazione è 
necessario aprire la finestra delle opzioni dal 
menù “File” > “Options”, passare alla scheda 
“Language”, selezionare la voce “ITA - italiano” 
e premere “Select”. Confermare quindi con “OK” 
ed infine chiudere e riaprire LogicLab affinchè 
le modifiche abbiano effetto.

12.b	 Creazione - caricamento di un progetto

Apertura di un progetto esistente:
•	 Con LogicLab aperto, fare click sul pulsante 

“Apri progetto” oppure selezionare uno degli 
ultimi progetti aperti dall’elenco proposto.

•	 Con LogicLab chiuso, entrare nella cartella del 
progetto e fare doppio click sul file con il nome 
del progetto desiderato che avrà l’icona  ed 
estensione “.plcprj”.

Creare un nuovo progetto:
Premere il pulsante “Nuovo Progetto”.
Nella finestra che appare, digitare un nome per il 
progetto ed identificare la cartella dove verranno 
inseriti i file del progetto. Selezionare infine il 
dispositivo che si vuole programmare.

Attenzione: selezionando il flag “rispetta maiuscole/minuscole”, una variabile che contiene una lettera 
maiuscola sarà intesa come diversa da un’altra di uguale nome ma con tale lettera minuscola. 
Consigliamo quindi di lasciare disabilitata tale selezione, per evitare confusione durante la stesura del 
codice programma.
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12.c	 Collegamento al target
Si elencano di seguito i requisiti necessari per il corretto collegamento tra target (dispositivo da 
programmare) e l’ambiente di sviluppo su PC (LogicLab).
Requisiti da verificare sul target:
•	 dispositivo acceso e avviato
•	 configurato con indirizzo IP statico compatibile con la rete dove si trova ed il PC con cui si 

dovrà connettere. Di default, l’indirizzo IP dei terminali HMI è 192.168.0.100, quello del PL500 è 
192.168.0.99, quindi il PC dove si sta sviluppando dovrà avere la stessa rete e classe (in questo caso 
192.168.0.XXX) ma indirizzo fisico diverso (cioè le ultime 3 cifre dell’indirizzo IP, con un qualsiasi 
numero compreso tra 1 e 255, diverso da 100). Se è necessario cambiare l’indirizzo IP del terminale 
rispetto a quello di default, fare riferimento alla configurazione del TD Control Panel, sezione “LAN 
ETH1” al par. 10.d.

•	 connessione con cavo di rete (diretto o cross) direttamente al PC o attraverso uno switch di rete
•	 SoftPLC in esecuzione (per questo fare riferimento alla configurazione del TD Control Panel, sezione 

“PLC LOGICLAB” al par. 10.c).

Requisiti da verificare sul PC di sviluppo:
•	 indirizzo IP compatibile con la rete esistente dove si trova e con l’indirizzo IP configurato nel target 

(vedi punti precedenti)
•	 antivirus/firewall che permetta la connessione a dispositivi nella rete (di norma sono già configurati 

correttamente)
•	 LogicLab configurato per connettersi al target collegato che si vuole programmare: per fare ciò, 

navigare sul menù “On Line” > “Imposta comunicazione” e nella finestra che appare, premere il 
pulsante “Properties” e poi alla voce “IP Address” inserire l’indirizzo IP del target, lasciando inalterato 
tutto il resto. Nel caso di reti molto lente o di una configurazione di rete con diversi switch, è 
possibile aumentare il valore “Timeout” (espresso in mS).

L’immagine rappresenta la configurazione di default

Confermare tutte le finestre premendo su “OK” e salvare attraverso l’icona  o attraverso il menù “file” 
> “Salva Progetto”.
A questo punto, per verificare che la configurazione del LogicLab e del target sia corretta, si può 
effettuare la connessione premendo l’icona  oppure dal menù “On Line” > “Connetti”. Se la 
connessione va a buon fine la barra di stato in basso a destra visualizzerà “CONNESSO” e “NO CODICE” 
ad indicare che il target è connesso e non ha codice al suo interno oppure “CODICE DIFF” ad indicare 
che il codice che si sta visualizzando non corrisponde a quello che risiede nel target.

12.d	 Compilazione e scaricamento del codice
Una volta inserito il codice progetto è necessario compilarlo per verificare che non ci siano errori, 
premendo il tasto F7, attraverso l’icona  oppure dal menù “Progetto” > “Compila”.
Se la compilazione va a buon fine si può trasferire il programma al target premendo il tasto F5, 
attraverso l’icona  oppure dal menù “On Line” > “Trasferimento codice”.
A questo punto la barra di stato visualizzerà “CONNESSO” e “SORGENTE OK” indicando che il programma 
in esecuzione nel target corrisponde a quello che si sta visualizzando sul PC.
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12.e	 La watch window
Se il programma in esecuzione nel target corrisponde a quello che si sta visualizzando sul PC, la barra 
di stato visualizza “CONNESSO” e “SORGENTE OK” ed è quindi possibile utilizzare la finestra di “Watch” 
per verificare, in tempo reale, lo stato delle variabili utilizzate nel progetto. Per abilitare la finestra 
di “Watch”, premere i tasti CTRL+T oppure usare il menù “Vista” > “Finestra strumenti” > “Watch”. Per 
aggiungere una variabile alla finestra di “Watch” è sufficiente trascinarla al suo interno oppure premere 
l’icona  e selezionarla manualmente.

Da questo momento, la finestra di “Watch” 
comincerà a visualizzare il valore della variabile 
inserita, in tempo reale.

Attraverso gli appositi pulsanti  è possibile inoltre salvare, caricare e aggiungere all’elenco 
delle variabili, una watch-list già esistente.

Se si desidera cambiare il formato di visualizzazione, è 
sufficiente selezionare la variabile e premere l’icona 
. Dalla finestra che appare selezionare quindi il formato 
desiderato e confermare con “OK”.

13	 Interfacciare Movicon 11 con LogicLab
NB: è richiesto Movicon 11.5 o successivi.

Da effettuare solo la prima volta:
Nel PC dove si sta sviluppando, scaricare dall’area dowload del sito Pixsys, nella sezione Movicon, il 
“MOVICON 11.6 Update-Aggiorna Driver.exe” corrispondente all’architettura del pc in uso. Doppio 
click per avviarlo e seguire le istruzioni a video.
Nel caso si utilizzi un Panel PC (TD750-TD850-TD900-TD910-TD920) va fatto anche sul Panel PC.
Premessa: con questa procedura vengono importate tutte le variabili di sistema del PLC e tutte le 
variabili create ed usate nel progetto PLC.
La creazione e l’aggiornamento dell’elenco delle variabili PLC avviene solamente se il programma 
LogicLab è compilato senza errori e scaricato sul target.

13.a	 Creazione di un nuovo progetto Movicon
Avviare il software e scegliere la piattaforma “Windows® X86 / X64” per i Panel-PC e “Windows® CE” per gli 
HMI e per il PL500 versione “WEB”. Se si sta creando un nuovo progetto Movicon seguendo il Wizard, 
al termine verrà visualizzata la finestra di configurazione del driver, passare quindi direttamente alla 
sezione “Configurazione del Driver” al par. 12.b. Se invece si sta installando il driver manualmente, seguire 
i passi successivi.
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Aggiungere il driver di comunicazione facendo 
click con tasto destro su “Real time DB” quindi 
“nuovo driver di comunicazione”.

Selezionare dal menù dei produttori “Pixsys” e 
poi “Pixsys SoftPLC Driver”.

Confermare con “OK” e fare doppio click sul 
driver appena creato per aprire la finestra di 
configurazione.

13.b	 Configurazione del Driver

Selezionare la scheda “Station” e aggiungere 
una nuova stazione con il pulsante “ADD”.

1.	 Inserire il percorso del sorgente del 
progetto LogicLab situato nel PC su cui 
si sta sviluppando. Questo permette di 
importare le variabili ed eseguire in modalità 
preview Movicon sul proprio PC di sviluppo, 
compresa la verifica della comunicazione con 
il SoftPLC. Per questa funzione, è necessario 
che nel passo successivo si indichi l’indirizzo 
IP del terminale che si sta programmando 
(solo al termine dello sviluppo si dovrà 
inserire l’indirizzo localhost 127.0.0.1 per far 
si che il progetto Movicon comunichi con il 
SoftPLC risiedente nella stessa macchina).

2.	 Questo campo si autocompila dopo aver inserito il percorso del punto 1: nel caso di utilizzo degli 
HMI e del PL500, non modificare il campo auto-compilato. Nel caso di Panel-PC (TD750-TD850-
TD900 ecc.) inserire il percorso dove è stato effettuato il download del progetto LogicLab (di 
default “D:\LLExec\NomeMioProgettoLogicLab.sym.xml”).

3.	 Se l’applicativo Movicon sarà eseguito nel Panel HMi o nel Panel-PC dove è presente anche il 
SoftPLC, inserire l’IP address 127.0.0.1.
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	 Se invece Movicon sarà eseguito in un Panel HMi o Panel-PC diverso da dove risiede il SoftPLC, si 
dovrà inserire l’indirizzo IP del softPLC.

4.	 Dalla sezione “General” assegnare un nome alla stazione, ad esempio: “PLC”.

Premere OK per salvare le impostazioni e uscire.

Ora è possibile importare le variabili del 
progetto LogicLab in Movicon.
Premere il tasto destro su “Pixsys SoftPLC” e 
selezionare “Importa database PLC”.

Premere il tasto “Read from PLC project”, verrà 
fornito l’elenco delle variabili disponibili.

Selezionare quindi le variabili che si vogliono 
importare e premere il tasto “Import”.

NB: Nel caso di importazione di una variabile di tipo array, questa sarà visualizzata come una struttura 
che porta il nome del array. I singoli membri dell’array saranno accessibili singolarmente con la sintassi 
NomeMioArray:NomeMioArray _X dove X è l’indice dell’array (a partire da 0).
Ora le variabili sono disponibili nel progetto di Movicon. Qualora ci fosse la necessita di importare 
nuove variabili, ad esempio nel caso di modifica del progetto di LogicLab, ripetere solo la procedura di 
lettura ed importazione delle variabili.

13.c	 Trasferimento del codice Movicon nel target
Per trasferire il progetto Movicon, usare l’icona:  

1.	 Selezionare il protocollo per il trasferimento: TCP
2.	 Inserire l’indirizzo IP del target (default per HMI/

PLC: 192.168.0.100)
3.	 Nel caso di HMI/PLC lasciare vuoto, nel caso di 

Panel-PC inserire user (o il nome dell’utente con 
cui si è effettuato l’accesso nel Panel-PC target).

4.	 Nel caso di HMI/PLC lasciare vuoto, nel caso di 
Panel-PC inserire 123456

5.	 Nel caso di HMI/PLC inserire \NandFlash\No-
meMioProgettoMovicon\, nel caso di Panel-PC 
inserire D:\NomeMioProgettoMovicon\.

	 In questo modo Movicon creerà una cartella 
chiamata NomeMioProgettoMovicon e scaricherà 
tutti i file del progetto dentro ad essa.

6.	 Premete il tasto “Trasferisci Progetto (Upload)“ per 
avviare il trasferimento (premere “Yes to All“ nel 
caso sia già stato scaricato un progetto prece-
dentemente e si voglia sovrascriverlo).

7.	 Una volta terminato la procedura di download, 
premere “Avvia Progetto sul Dispositivo“ per farlo 
eseguire sul target (il progetto in esecuzione 
sarà terminato e si avvierà l’ultimo trasferito).
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NB: Nel caso si voglia trasferire più progetti/versioni differenti, è sufficiente cambiare la cartella di 
destinazione (va mantenuto comunque la prima parte \NandFlash\). Dal TdControlPanel si dovrà 
scegliere quale progetto tra i presenti nella memoria del dispositvo si dovrà avviare in automatico 
all’accensione del target (vedi paragrafo 10.b).

14	 Simulazione dell’intero progetto SoftPLC + SCADA
Da LogicLab, lanciare il simulatore dall’icona  oppure dal menù “Debug” > “Modo simulazione”. Nella 
finestra che appare, creare una nuova area di lavoro indicandone il nome e la cartella di destinazione 
(di default è selezionata la cartella dove risiede il progetto).
A questo punto, il simulatore risulterà avviato e connesso (la finestra di stato segnalerà lo stato 
“CONNESSO”) ma senza codice (la finestra di stato segnalerà lo stato “NO CODICE”), trasferire quindi il 
codice premendo il tasto F5, attraverso l’icona  oppure dal menù “Online” > “Trasferimento codice”.
Verificare che la barra di stato visualizzi “CONNESSO” e “SORGENTE OK”. In caso si visualizzi ancora “NO 
CODICE”), riavviare il simulatore premendo l’icona  oppure dal menù “On-line” > “Target reboot”.

Da Movicon, entrare nella finestra di configurazione del driver Pixsys e configurare come segue:
1.	 Entrare nella cartella dove risiede il 

progetto LogicLab e selezionare il file 
NomeMioProgettoLogicLab.sym.xml

2.	 Entrare nella cartella dove il simulatore 
sta lavorando, impostare come filtro per 
il tipo di file “All files (*.*) e selezionare il 
file NomeMioProgettoLogicLab.sym.simul. 
Fare molta attenzione all’estensione del 
file, in quanto nella cartella di progetto 
esistono molti file con lo stesso nome ma 
con estensione differente.

3.	 Impostare l’indirizzo localhost: 127.0.0.1
4.	 Dalla sezione “General” assegnare un 

nome alla stazione, ad esempio: “PLC”.
A questo punto, per lanciare la simulazione dell’interfaccia grafica collegata al simulatore (che sta 
già eseguendo il codice precedentemente scaricato) è sufficiente premere i tasti Alt+F12, l’icona  
oppure dal menù “File” > “Avvia Progetto”.
Per terminale la simulazione, premere i tasti Alt+F12 oppure l’icona  nella barra che appare in alto.

Responsabilità limitata
Pixsys S.r.l. garantisce le proprie apparecchiature elettroniche per un periodo di 12 mesi a decorrere 
dalla data di fatturazione. La garanzia del Costruttore è limitata alla riparazione o sostituzione delle 
parti che presentino difetti di fabbricazione e che siano rese franco nostra sede citando il numero di 
autorizzazione al reso (procedura interna autorizzazione RMA). Pixsys declina ogni responsabilità per 
incidenti e danni a persone o cose derivanti da manomissione (inclusi tentativi di riparazione da parte 
di personale non autorizzato), condizioni ambientali non idonee, installazione scorretta, uso errato, 
improprio e comunque non conforme alle caratteristiche dello strumento dichiarate nella documen-
tazione tecnica. In nessun caso la responsabilità del costruttore eccede il valore della strumentazione. 
La garanzia non copre in alcun modo i problemi derivanti dall’installazione di applicativi software 
successiva alla vendita, ed in particolare i danni conseguenti all’esecuzione di malware. Eventuali 
interventi di assistenza da parte di Pixsys per il ripristino di sistema operativo o programmi saranno 
soggetti alla tariffa di assistenza vigente.
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Note / Aggiornamenti





Read carefully the safety guidelines and programming instructions contained in 

this manual before using/connecting the device.

Prima di utilizzare il dispositivo leggere con attenzione le informazioni di sicurezza 

e settaggio contenute in questo manuale.

PIXSYS s.r.l.
www.pixsys.net

sales@pixsys.net - support@pixsys.net 

online assistance: http://forum.pixsys.net

2300.10.258-RevE
220221
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